
START NEW PROJECT

Whether you are a novice or an experienced editor, this course is designed to teach you 
everything you need to feel comfortable using Adobe Premiere Pro. 
Follow along with my tutorial video on the Adobe Video YouTube channel.
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Start New Project

Image 1: Create a New Project.

Image 2: Create a new Sequence by dragging the clip to New Item.

Image 3: How I organize every folder within my hard drives.

Open Premiere Pro by double-clicking on the icon on your 
computer. The first screen will show you your previous 
projects (if you have any) as well as options to create a new 
project or open a previous project. 

To create a new project, click on “New Project” in the top 
left corner of the screen (Image 1).

New Project Window
Give your project a name in the “Project Name” field by 
replacing the word “Untitled” with your project name. 

You’ll need to store your project on your hard drive in a 
specific location, so you can find it later. Choose that location 
by clicking on the drop-down menu in the Location field 
and selecting “Choose Location” (Image 2). This means 
that Premiere Pro will create a project file (file extension 
.prproj) in that location. Whenever you need to open your 
project again, you’ll find that project file and double-click on 
it to open it again in Premiere. Select “Skip Import Mode” 
if you don’t want to Import (put clips into your project) using 
Premiere’s “Import Mode” window (Image 4).

Ideally, you already have a folder on your computer or hard 
drive that is dedicated to only your Premiere Pro projects. If 
you don’t, this is how I organize every project folder, making 
sure there is a subfolder called PREMIERE (Image 3). 

If you choose not to “Skip Import Mode” you will be directed 
to a window that will help you import clips into your project 
before you even open the project. In the “Devices” section 
on the left, find the hard drive that contains your footage 
and pull it up on the main screen. 

You can now select your footage (Image 4) one-by-one or 
bulk-select it by pressing the first clip, holding down SHIFT, 
and then pressing the last one. Or CTRL+A to select all.

The order in which you select the clips will be the order 
in which they are placed on your timeline. To create a 
sequence with those clips, you can check off “Create New 
Sequence” on the right, giving your new sequence a name.

You can also select “Media analysis” which will start 
analyzing your clips for visual elements such as objects and 
words, so you can later search for them in the Search Panel.

Image 4: Import Mode Window, with all clips selected (blue), “Create new 
sequence” checked, “Media analysis” checked.

Import Mode



6PART 1: FOUNDATION

Layout and Windows

THESE ARE THE FIVE BIG WINDOWS YOU SEE WHEN YOU START A PROJECT. THEIR SIZES CAN BE MOVED AROUND BY HOVERING 
OVER THE BOUNDARY BETWEEN THEM, CLICKING, AND DRAGGING. 

YOU CAN MAKE ANY OF THEM FULL-SCREEN BY SELECTING IT (IT WILL OUTLINE IN BLUE) AND PRESSING THE “~” KEY ON YOUR 
KEYBOARD, USUALLY LOCATED IN THE TOP LEFT. IF YOUR LAYOUT LOOKS DIFFERENT, YOU CAN RESET IT BY GOING TO WINDOW 
> WORKSPACES > RESET TO SAVED LAYOUT OR CHOOSE THE “EDITING” LAYOUT FROM WINDOW > WORKSPACES.

PROJECT PANEL
This is where you will organize your project. Think of this as your Finder (or File Explorer on PC). Here you will create 
folders (called Bins), import your clips, view and organize footage, and prepare your clips before going into your 
timeline. Any clip deleted or altered here will not delete or alter the original clip on your hard drive.

TIMELINE PANEL
This is where you will view, create, and organize your sequences. You can have multiple sequences open at the same 
time and they will all appear as tabs across the top. The timeline plays from left to right, from zero seconds until the 
end of your sequence. As you are playing through, you’ll see the Current Time Indicator as a blue line showing you where 
you are in your timeline. You can stack clips on top of each other on different tracks, and whichever clip is on top is the 
clip that will be shown.

SOURCE MONITOR
If you double-click a clip from the Project Panel, it will show up in the Source Monitor, where you can play it. You 
can also select just a portion of the clip using in/out points (covered later).

PROGRAM MONITOR
Plays back the sequence from your Timeline Panel.

PROPERTIES PANEL
Once you have one or more clips selected on your timeline, certain aspects of those clips can be adjusted here, like the 
size of the clip, the position, scale, rotation, the volume, etc. You can also edit graphics here.

k



WHERE: PROJECT PANEL
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Click on the folder icon on the bottom right of the Project 
Panel (Image 1) to create a new bin. You can rename it right 
now or rename it later by clicking once on the name.

If you drag a folder into your Project Panel from your 
computer (Image 2), bins and sub-bins will automatically be 
created to match your folder structure.

You can drag clips into the Project Panel from your Finder (or 
File Explorer on PC). If you drag them on-top of an existing 
bin, they’ll be placed into that bin. You can also double-click 
in an empty area of the Project Panel and select the clips 
you want to import. Or you can go to FILE > IMPORT.

Click List View (Image 3) on the bottom left of the Project 
Panel to view the files in your Project Panel as a list. 

If you double-click on a bin, the items inside the bin will 
appear as a new tab in the Project Panel (Image 4).

IMPORT CLIPS

LIST VIEW

Create Bins & Import Clips

CREATE BIN

Image 1: Create a New Bin by clicking on the New Bin button.

Click Icon View (Image 5) on the bottom left of the Project 
Panel to view the files in your Project Panel as thumbnails. 
You can change the size or order of the thumbnails with the 
options to the right.

ICON VIEW

Image 2: You can drag entire folders into the Project Panel.

Image 3: List View Button.

Image 6: Clips displayed in Freeform View.

Image 5: Clips displayed in Icon View.

FREEFORM VIEW
When you choose to view your thumbnails in Freeform View 
(Image 6), you can move them wherever you like within the 
Project Panel. 

You can stack, align, group, or change their sizes (RIGHT 
CLICK > CLIP SIZE). This is more of an advanced method 
of clip organization that allows you to make groupings of 
clips and organize them in a “tabletop” fashion, like 
sticky notes. You’ll notice you cannot alphabetize them in 
this view.

Image 4: Bin opens in separate tab.
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WHERE: PROJECT PANEL

Color Code Clips

Image 1: Bin “FOOTAGE” (labeled Mango) and all the clips inside the bin (labeled 
Iris - the default blue color) are now being labeled Violet.

Image 2: Create a new Sequence by dragging the clip to New Item.

Image 3: Select the “03 SEQUENCES” Bin and choose “Sequence” from New Item menu.

Before bringing the clips into a sequence, I like to color-
code them. Whether this is by camera, by speaker, by theme 
- whatever your color-coding system, it’s easier to label the
clips with colors while they are still in the Project Panel.

Simply select the clips you’d like to label (hold down 
SHIFT to select them in a sequence or CMD/CTRL to select 
individual clips), RIGHT CLICK, and choose LABEL > select 
your label color (Image 1). 

Now when you put your clips into your timeline, they will 
retain those color labels. You can always change the label 
of the clip once it is already in the timeline, but this will not 
change the label color of the same clip in the Project Panel.

WHERE: PROJECT & TIMELINE PANELS

Create Sequence

Drag any clip from the Project Panel onto the “New Item” 
button on the bottom of the Project Panel (Image 2). This 
will create a new sequence with the same name, dimensions, 
and properties as the clip.

You can rename and reorganize the sequence later inside 
the Project Panel.

Create a new Bin for “Sequences” and select it. Click the 
“New Item” button and select “Sequence...” (Image 3).

In the New Sequence Window (Image 4), you can choose 
from many presets or create your own. The standard settings 
for a standard YouTube video are:

Timebase: 23.976 fps (frames per second)
Frame Size: 1920 x 1080 pixels
Pixel Aspect Ratio: Square Pixels (1:0)

Be sure to give your new sequence a name and click “OK.”

FROM SCRATCH

FROM A CLIP

Image 4: New Sequence window.
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WHERE: PROJECT PANEL

WHAT: QUICKLY PREVIEW CLIPS

Hover Scrub 
and the In/Out 
Workflow Image 1: The Icon and Freeform view are at the bottom left of the Project Panel.

Image 2: The blue line in “LIGHT_A_02.mp4” shows the range selected.

Image 3: If a clip is selected, scrub by holding and dragging this time indicator.

Image 4: The portion of the clip in the Source Window that has been selected.

PRE-EDIT WHILE BROWSING CLIPS IN THE BIN
You don’t have to drag your entire clip into your sequence, 
you can pre-trim it beforehand! Make sure you are 
viewing your clips in Icon or Freeform View (Image 1). 
Without any clips selected (no blue outline around the 
clips), hover your mouse left to right over each thumbnail 
to scrub through the entire clip.

Once you land on where you want your trim to start, hit the 
“I” key on your keyboard, for “In Point.” Keep hovering 
until you get to your desired “Out Point” and hit the “O” 
key. After you use the “I” and “O” keys to select a portion 
of your clip, you should see your selection reflected as a 
blue line underneath your thumbnail (Image 2). 

If a clip is selected (blue outline) you can still scrub 
through the clip by holding and dragging the time 
indicator underneath the thumbnail (Image 3). 

To put that portion of the clip into your sequence, press 
the COMMA (,) button. That will insert the clip wherever 
your playhead (blue line) is on your sequence, while 
rippling any trailing clips back. If you don’t want the 
trailing clips to ripple, instead of pressing COMMA, you 
will press PERIOD (.).

IN/OUT FROM THE SOURCE MONITOR
If you double-click on the clip in your Project Panel, it 
will pull up larger in our Source Monitor. From there, you 
can also use the In/Out workflow on the next page to 
select a portion of a clip to then put into your timeline.

The gray section of the clip (Image 4) indicates 
which portion of the clip has been selected. You can 
also drag just the video (Image 5) or just the audio 
from that selection directly into your sequence.

Image 5: Dragging just the video from a portion of a clip into the sequence.



WHERE: SOURCE MONITOR OR 
            PROGRAM MONITOR

FAST FORWARD SHORTCUT: L

Faster Playback

Scrub quickly through your footage using the JKL keys. 
The more times you press J and L, the faster the scrub.

REWIND SHORTCUT: J

STOP SHORTCUT: K

The track on which Source 
Patching is turned on is 
where new clips are dropped 
in via Insert and Overwrite. 
This helps when you’ve got 
lots of tracks and need to 
drop specific clips into a 
specific track.

The tracks that have Track 
Targeting turned on work 
with basic timeline shortcuts 
and copy/paste.
This helps if you want to use 
shortcuts on multiple tracks 
at once, or just work on a 
specific track.
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WHERE: TIMELINE

INSERT SHORTCUT: , (COMMA)

SHORTCUT: UP OR DOWN ARROWS

OVERWRITE SHORTCUT: . (PERIOD)

Insert & 
Overwrite

Go to Cut Point

Put your playhead (blue line) where you’d like your new clip to 
go in your sequence (Image 1), then select the clip that you’d 
like to add from the Project Panel. Use “,” to insert the new 
clip and have all trailing clips ripple to the right (Image 2) or 
use “.” to overwrite the new clip on top of your existing ones 
(Image 3). The playhead jumps to the end of the new clip, so 
you can keep adding to the sequence without readjusting the 
playhead every time.

Not working? Is “Source Patching” enabled for that track? 
Look at the space to the LEFT of your track lock (it should say 
say V1, V2, A1, etc) and turn it blue (not gray) by clicking on it.

Make your playhead jump directly to the next cut point in 
your sequence by clicking the up or down arrows.

Not working? You might have turned off “Track 
Targeting.” Look at the space to the right of your track 
lock and turn it blue (not gray) by clicking on it.

Image 1: The playhead is the blue line in-between the blue and purple clips.

Image 2: The green clip was inserted and the purple clip jumped right (rippled). 

Image 3: The green clip overwrote the beginning half of the purple clip.

BRING IN CLIPS WITHOUT DRAGGING
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Track Locking
Click the track lock icons to prevent yourself from being able to touch or manipulate anything on those tracks.

Audio Track Solo

Video Track Visibility

Audio Track Mute

Click the eyeball icons to not see those tracks in your timeline.

Click the M icon (it should turn green) to not hear that audio track during your playthrough. 

Click the S icon (it should turn yellow) to hear only that track playing. It also makes all other tracks Mute. You can “solo” 
more than one track, just as you can mute more than one track. 



IF THE CLIP IS ALREADY IN YOUR TIMELINE

BEFORE YOU ADD THE CLIP TO YOUR TIMELINE
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Unlinking Clips
When you drag the entire clip from the bins into your 
timeline, if the clip has audio - the audio will also appear 
in your timeline. This is because the video and the audio 
are “linked.” Here are 6 ways to unlink your audio:

Image 1: Drag Video Only button.

Image 2: Unlink Option in the pop-up menu.

Image 3: Disable Linked Selection from the Sequence Menu.Image 4: Once disabled, the Linked Selection button on the sequence is gray.

Select the clip (or group of clips) and press 
CMD+L (CTRL +L on PC).

Select the clip (or group of clips), right click, and select 
“Unlink” from the list (Image 2).

Disable the “Linked Selection” button on the sequence, 
right next to the Snap button (Image 4). This unlinks all 
the clips in that sequence, but not in the whole project.

Go to the Sequence menu above and deselect “Linked 
Selection” (Image 3). This will make all the clips in the 
whole project unlinked.

Hold down OPTION (ALT on PC) while selecting a clip (or 
group of clips) and after you let go of the mouse, press 
Delete to delete them. Otherwise, clicking anywhere else 
will just make them all linked again.

Double-click on the clip in the Project Window (in your 
bins) and pull it up in your Source Monitor. Hold down 
the the film strip icon at the bottom of the Source 
Monitor (Image 1) and drag into your timeline. 



Some tools have more tools hiding underneath! To access them, CLICK AND HOLD onto the tool until the sub-menu pops up.

SELECTION (V) Select clips in the timeline.

TRACK SELECT FORWARD/BACK (A/SHIFT+A) Select all 
the clips after or before your cursor.

RIPPLE EDIT (B) Adjust an edit point and all other clips move 
over (ripple) to make room.

ROLLING EDIT (N) Adjust an edit point between two clips 
without moving anything else in the timeline.

RATE STRETCH (R) Change the duration of the clip while 
changing the speed.

REMIX TOOL Change the duration of a music clip without 
changing the speed. AI-powered tool with Adobe Sensei.

RAZOR (C) Cut a clip (or multiple clips) into two.

SLIP (Y) Move a clip’s in and out points simultaneously, without 
affecting any of the other timeline clips.

SLIDE (U) Slide a clip left and right on the timeline while over-
riding the other clips that are on either side of it.

PEN (P) Create and move anchor points.

SHAPES You can create a RECTANGLE, CIRCLE, OR POLYGON 
When the tool is selected, you can click and drag directly in the 
Program Window. A new clip will appear on the top Video Track. 
Shapes can be edited inside the Properties Panel.

HAND (H) Drag the timeline view side to side.

ZOOM (Z) Zoom into the timeline to see it in more detail.

TYPE (T) OR VERTICAL TYPE Type directly onto the screen in 
the Program Window. A new clip will appear on the top Video 
Track. Text font, size, color and other properties can be edited 
inside the Properties Panel.

GENERATIVE EXTEND Drag the length of an audio or video 
clip to create new frames using commercially safe AI powered 
by Adobe Firefly. This creates up to 2 seconds of video foot-
age and up to 10 seconds of audio. This is a premium feature.

13PART 2: BUILDING

Tools Panel Basics 



Image 1: Edit tools in the Tools menu.
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Moving Edits

Not working? Possible reasons:

1.  You are trying to extend a clip on the timeline,
but you are already at the beginning or end
of that source media and the edit cannot be
extended. Try Generative Extend Tool.

2. You are trying to shorten (contract) a clip, but
have other clips on different tracks getting in
the way of the ripple. If you don’t want certain
tracks interfering with the ripple effect (like
for example the music track), you can lock
those tracks with the Track Lock (Image 4).

RIPPLE EDIT

Image 3: Extending end point of yellow clip to the right.

Image 2: Ripple Edit cursor hovering over end point of yellow clip.

Image 4: Track lock for music track (Green, Track A2) is on.

Image 5: Rolling Edit cursor hovering 
over the end point of yellow clip.

Image 6: The extended yellow clip over-
wrote half of the following blue clip.

WHERE: TIMELINE

RIPPLE EDIT SHORTCUT: B

ROLLING EDIT SHORTCUT: N

These tools will help you move the edit point (cut point) 
between clips, directly in the timeline. You can access 
these tools via the Tools Menu (Image 1) or via shortcuts.

The rest of the clips in the timeline will ripple forward or 
back, unlike when you use the selection tool (V) to trim a 
clip, where none of the other clips in the timeline move.  

Press “B” on your keyboard and place your 
mouse at the edit point you want to manipulate. You 
should see a yellow arrow indicator (Image 2). 

STEP 1:

Click and drag your edit point left or right to 
change the length of your clip in the timeline (Image 3). 
STEP 2:

ROLLING EDIT
Press “N” on your keyboard and place your 

mouse at the edit point. The cursor should become four 
red arrows and your edit point should turn red (Image 5). 

STEP 1:

Click and drag your edit point left or right to 
extend or contract the length of your clip in the timeline.
STEP 2:

The clip immediately on the other side of the edit will 
adjust its own duration while not causing any of the 
other clips on the timeline to ripple (Image 6).

PART 2: BUILDING



Image 1: To move this yellow clip up a track, hold OPTION (ALT) and press UP.

Image 2: The yellow clip over-wrote the first half of the purple clip above it.

Image 3: As yellow clip is slid left, blue clip gets shorter & green clip gets longer.

Image 5: Slip Clip Display in the Program Window.

Image 4: As yellow clip is slipped, none of the clips around it change.
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NUDGE LEFT/RIGHT
To move a clip one frame left or right, hold down OPTION 
(ALT on PC) and click your left or right arrow keys.

NUDGE UP/DOWN
To move a clip to the track directly above or below it 
(Image 1),  hold down OPTION (ALT on PC) and click your 
up or down arrow keys. This will over-write anything 
already on the target track (Image 2).

DUPLICATE AND DRAG
Instead of using copy/paste commands to duplicate a 
clip, select the clip while holding down OPTION (ALT on 
PC) and drag the duplicated copy to its new location.

Sliding a clip will not change its duration or contents, it 
will just slide the clip left or right on its track while its 
neighboring clips elongate or shorten, without rippling. 

SLIDE CLIP

SLIP CLIP
Slipping a clip will not change its duration or location 
on the timeline. It will change the content within the 
segment of the clip itself, as you slip along the contents 
of the full original clip (Image 4).

Moving Clips

SELECT LINKED CLIP WITHOUT UNLINKING
If your Audio and Video are linked in the same clip but 
you want to select just the audio, hold down OPTION 
(ALT on PC) and click just the audio.

SELECT ALL AFTER (OR BEFORE) CURSOR
To select all clips at and after your mouse, change 
your cursor to Track Select Forward Tool (A) and click 
anywhere in the timeline. SHIFT + A will select everything 
before your cursor. Locked tracks will not be affected.

WHERE: TIMELINE

SELECT AFTER CURSOR SHORTCUT: A

SELECT LINKED: OPTION (ALT) + CLICK

DUPLICATE CLIP: OPTION (ALT) + DRAG

NUDGE CLIP LEFT/RIGHT 1 FRAME: 
OPTION (ALT) + LEFT/RIGHT ARROWS

SLIDE CLIP SHORTCUT: U

SLIP CLIP SHORTCUT: Y

NUDGE CLIP UP/DOWN TRACKS: 
OPTION (ALT) + UP/DOWN ARROWS

Press “U” and select your clip. STEP 1:

Drag your clip left or right to its new position, 
changing the length of the neighboring clips (Image 3).
STEP 2:

SELECT BEFORE CURSOR SHORTCUT: SHIFT +A

Press “Y” to activate Slip Tool.STEP 1:

Click and drag left and right over the clip you 
want to slip. A new display will appear in the Program 
Window (Image 5). The frame at the head end of the 
segment will appear on the bottom left, the frame at the 
tail end of segment on the bottom right, the last frame of 
the previous clip will appear top left, and the first frame 
of the next clip will appear top right.

STEP 2:

PART 2: BUILDING
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Mark The Sequence

STEP 1: Play through your track by pressing the SPACEBAR or the PLAY BUTTON at the bottom of the Program 
Window. Every time you find a place you’d like to put a marker, press the “M” button on your keyboard. Markers can 
also be rearranged and dragged around the timeline.

STEP 2: If you want to place a durational marker to help you indicate a certain segment, you can click on the marker 
and hold down OPTION (ALT on PC) to drag it out to your desired length. 

MARKERS ARE FOR YOU TO REMIND YOURSELF WHAT TYPE OF CONTENT YOU’VE GOT IN YOUR TIMELINE AND 
WHERE IT IS LOCATED. BEFORE YOU ADD MARKERS, MAKE SURE YOU HAVE THE FOLLOWING TWO SETTINGS:

IN THE SEQUENCE MENU: Uncheck “Selection 
Follows Playhead” - this will allow you to slice across 
the entire timeline stack without Premiere always 
selecting the top clip by default. 

IN THE MARKERS MENU: Check “Ripple Sequence 
Markers” - this will make sure your markers are always 
connected to the clips in your sequence. If you change 
your sequence, the markers ripple accordingly.

STEP 3: To change colors or add notes to a durational marker, double-click on it. Here, I titled it “JIGSAW” and 
colored it red. The markers will match their location both in the timeline and in the Program Panel.

PART 2: BUILDING



Image 1: An edit inserted across all video layers and 3 audio layers at the marker.
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Edit with Markers and Shortcuts

Image 3: The two pink clips at the top are disabled (darker colors)

Image 2: All edits have been inserted at all the markers.

Image 4: All clips under playhead disabled except the music track.

Image 5: Five edit points have been selected by drawing a marquee. Notice the 
music track wasn’t selected even though the box is on it - because it is locked.

Click SHIFT + M  to jump your playhead to the 
next maker. Click M to cut across all your video layers, 
also known as “insert edit” (Image 1). This will only work 
if track targeting is selected across all layers (Page 10) 
and your music track is locked (Page 11).

SELECT MULTIPLE EDIT POINTS AT ONCE

Insert a cut at each marker (Image 2).

By default, the clip showing is always the top-
most clip. Instead of deleting the clips on top to get to 
the clip you want, just disable them by dragging a box 
around the clips you want to disable and using  SHIFT + 
CMD + E (SHIFT + E on PC) to disable them. 

In Image 3, the pink clips on track V2, have been disabled 
and their colors have turned darker. 

In Image 4, all of the tracks under the playhead have 
been disabled except the music track (green).

STEP 2

STEP 3

STEP 1

To manipulate the entire column of edit points, you 
first need to select them. Hold down CMD (CTRL on 
PC) and draw a box around the edit points you want to 
select. They will turn red (Image 5). This can enable you 
to copy/paste transitions between multiple edit points 
or give you the ability to use the shortcuts on the next 
page across multiple edit points.
CLOSE GAP

If there is a gap that you’d like to close, you can RIGHT 
CLICK on it and select “Ripple Delete.”

Closing all gaps requires you to create a shortcut. Go to 
EDIT > KEYBOARD SHORTCUTS, type in “Gap” in the 
search bar and type in a shortcut for Close Gap.

PART 2: BUILDING



18

WHERE: TIMELINE AND 
 EFFECT CONTROLS PANEL

Motion Controls: Zoom and Pan
If you want to add a zooming movement or pan across an 
image or clip, Premiere Pro gives you an easy way to fine-
tune this process, using keyframes.

Image 1: Place your playhead where the movement should start.

Image 2: Effect Controls Window.

Image 3: Enable Scale keyframes.

STEP 1: Select the clip you’d like to pan or zoom (here it is the purple clip MOLDING_A_40.mp4) and place your 
Playhead (blue line, Image 1) where you’d like the movement to start. 

STEP 4: Click on the number that represents the scale and type in a new scale at the new keyframe (Image 7).

STEP 2: In the Effect Controls Panel (Image 2), enable keyframes by clicking the stopwatch next to the “Scale” 
property. The stopwatch should turn blue (Image 3) and the keyframe should appear in the work area (Image 4).

STEP 5: Complete this same keyframe process for the “Position” property (Image 8). Instead of typing in each 
value, you can also hover your mouse over the number and drag the mouse left to right to change the value (Image 9).

Image 4: First keyframe is placed.

STEP 3: Move your playhead to where you want your scaling movement to end (Image 5) and place a keyframe there 
as well by clicking on the keyframe button (Image 6). Keep your playhead at that keyframe.

Image 5: Move your playhead (blue line) to where the movement should end. Image 6: Click to make a new keyframe.

Image 7: Type in a new scale value. Image 8: Keyframes have been added for Position property. Image 9: Hover over number, drag to change.

PART 2: BUILDING



Stabilization Result Options in Warp Stabilizer. Stabilization Method Options in Warp Stabilizer.

Border Framing Options in Warp Stabilizer. Advanced Tab options for Synthesize Edges in Warp Stabilizer.

“Position” will just undo the shake in your clip, not modifying the dimensions. Use this when the camera is generally staying 
in one place and pointed in one direction. “Position, Scale, Rotation” will take into account the camera’s movement. 

You can always click “Preserve Scale” if you are moving forward or back on a subject and you don’t want the stabilizer to 
compensate for that.

METHOD

Framing is how you want your clip to be treated post-stabilization. By default, the “Stabilize, Crop, Auto-scale” is on, 
which uses AI to find the best re-cropping for your clip. This is very useful if you have a larger-sized clip (like 4K) in a smaller-
sized sequence (like 1080). 

However, I prefer to select “Stabilize Only” and have the rough edges of my clip show, then scale the clip as I see fit, manu-
ally. If you are stabilizing a clip that is the same pixel dimensions as your sequence and you don’t want to lose resolution by 
cropping, you can try the “Stabilize, Synthesize Edges” option, which will add additional pixels (fill in the blank 
space) by analyzing the frames earlier and later in time. To get a more accurate analysis, increase the “Synthesize Input 
Range” in the Advanced tab. In order to have a more seamless transition between footage and synthetic edges, use the 
Edge Feather option and use the Synthesis Edge Cropping to crop into your footage slightly, giving a less harsh edge.

FRAMING
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Clip Adjustment: Warp Stabilizer

“No Motion” will freeze the motion of your frame in place - making your shot look like a tripod shot. “Smooth Motion” will 
make your camera look like it is floating and smooth out the bumps in handheld footage. 

STABILIZATION RESULT

WHERE: EFFECTS PANEL, EFFECT CONTROLS PANEL, AND PROGRAM WINDOW

TO ADD WARP STABILIZER, FIND THE EFFECT IN THE EFFECTS PANEL UNDER VIDEO EFFECTS > DISTORT AND 
DRAG IT DIRECTLY ONTO YOUR CLIP OR DOUBLE-CLICK IT WITH YOUR CLIP SELECTED IN THE TIMELINE.

PART 2: BUILDING



Before Corner Pin

Before Gaussian Blur

After Corner Pin

Gaussian Blur - no “Repeat Edge Pixels” Gaussian Blur - with “Repeat Edge Pixels”Before Gaussian Blur Gaussian Blur - no “Repeat Edge Pixels” Gaussian Blur - with “Repeat Edge Pixels”

Original Clip Flip Horizontal Flip Vertical

Blurs your clip. Select “Repeat Edge Pixels” if you don’t want the edges to feather. Also try Camera Blur or Compound Blur!
GAUSSIAN BLUR

VIDEO EFFECTS

Simple way to flip your clip. I use these mostly to maintain consistency of framing or motion.
HORIZONTAL AND VERTICAL FLIP
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More Clip Adjustments
Select the clip you’d like to change the speed of. You can either RIGHT CLICK > SPEED/DURATION and enter a new dura-
tion or type a new speed, or you can change your cursor to the Rate Stretch tool by clicking “R.” Now you can hover over the 
end of any clip and drag it shorter or longer, therefore dynamically stretching its duration.

Assigns position values to the corners of your clip so you can skew it as needed.
CORNER PIN

RATE STRETCH

All of the following can be found in the Effects Panel and dragged directly onto any clip in the timeline.

PART 2: BUILDING
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Sync 1 Video Clip with 1 Audio Clip

Image 1: Select the A/V clip and its accompanying audio clip in the Project Panel.

Image 2: Use Audio track channel as the Synchronize Point.

Image 3: Drag your new Merged Clip onto the timeline, everything should be lined up. Mute the audio tracks of the original AV clip.

WHERE: TIMELINE & PROJECT PANEL

Select both the AV clip and your audio clip 
from the Project Panel by holding down CMD (CTRL on 
PC) as you click on both of them. 

You can see which audio clips go with which video clips 
either by listening through to them or taking a look at 
the Media Duration to give you a clue (Image 1).

STEP 1:

RIGHT-CLICK and select “Merge Clips.”STEP 2:

When syncing a video clip to an audio that was 
recorded externally, it is important to also record audio 
accompanying the video clip. This will allow you to use 
the scratch audio from the AV clips (those from your 
camera) to sync the external audio. 

In the Merge Clips window, you can give 
your new merged clip a name if you want. The most 
important thing is to select “Audio track channel” as 
your Synchronize Point (Image 2). Click OK.

STEP 3:

Your new merged clip should appear in your 
Project Panel. Now you can drag it onto your timeline. 
If you did not previously select “Remove Audio from AV 
Clip” in the Merge Clips menu, the audio from the AV 
clip will still be there for reference. You can disable it by 
right-clicking and selecting “Disable” or you can mute 
the entire track (Image 3).

STEP 4:

PART 2: BUILDING

NOTE: IF YOU CHOOSE TO SEND YOUR PROJECT OUT FOR FINISHING IN A THIRD-PARTY AUDIO APPLICATION, 
IT IS BETTER TO USE THE MULTICAM SYNC WORKFLOW DESCRIBED ON THE NEXT PAGE



Image 1: Selecting the clips that are meant to be synced.

Image 2: My preferred settings for multicam sync.
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Multi-Cam Sync Workflow
WHERE: PROJECT PANEL (BINS) AND TIMELINE PANEL

Synchronize audio and video files from multiple cameras and sound devices at once. This workflow is for those who want 
to be able to see all of their video feeds at the same time. It helps if your files are organized and you know which files 
from which cameras are meant to be synced.  

Select the clips you want to sync from the bin by 
holding down CMD (CTRL on PC) and clicking each 
one. In the example on Image 1, I know WIMB_A_01, 
WIMB_B_01, and WIMB_C_01 are the three camera 
files meant to sync with WIMB_001 - the audio file.

Tip: if your clips aren’t organized, you can play them through or check 
the media duration to see if the clips have a similar length. 

RIGHT CLICK and select “Create Multi-Cam Source Sequence.”

Determine what type of sync is required. If you were recording timecode (most cinema cameras do this) with a time-
code-generator box, select that. If you’re shooting on a phone or DSLR/mirrorless camera and you were recording audio 
on the camera itself (we call this “scratch audio”) you can select “Audio track channel” as your Synchronize Point.

STEP 2

STEP 3

STEP 1

I also like to deselect “Move source clips to Processed 
Clips bin” because that disrupts the organization I have in my 
Bins.

However, this is useful to select when you don’t know which 
clips go with which audio, so you’re selecting everything in your 
bins all at once and syncing that in a big chunk. If the 
synchronization fails on any of the clips, you’ll know because those 
clips will be the ones left in your original bins, while those clips 
that have been synced (or “Processed”) will be moved to a new 
“Processed Clips” bin.

I also like to select “Enumerate Cameras” because this 
assigns a number to each of my cameras, making it easy to switch 
between them by simply pressing the number keys on my 
keyboard. 

You can also create a custom name for the Multi-Cam Source 
Sequence (let’s shorten that to MCSS for this guide) that is 
about to be created. Or you can let the MCSS take on the name of 
one of the video or audio clips that are inside it. 

The new MCSS that is created after you click “OK” is put into 
your Project Window loose - not attached inside any existing Bin 
(Image 3, next page). 

PART 2: BUILDING



Image 3: Multi-Cam Source Sequence in the Project Panel.

Image 4: Disable this button to drag MCSS in as separate synced clips.
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Multi-Cam Sync Workflow (Cont.)
STEP 4

Drag the MCSS onto your timeline. If the first button 
under the timer is disabled (no gray background), 
the MCSS will split back into individual clip layers 
as it is being dragged into the timeline (Image 4). 
Make sure “Multi-Cam Follows Nest Setting” is 
enabled in the sequence menu (Image 5).

If that same button is enabled (gray background), 
the MCSS will look like it’s just one video layer. But 
in fact, this is special type of Nested Sequence and 
allow you to use Multi-Cam Editing (Image 6).

STEP 5
You’ll need to enable 2 buttons in your Button Editor 
that don’t come standard. Go to the “+” icon on the 
bottom right corner of the Program Window (Image 
7) and add the Multi-Cam Record button and the 
Multi-Cam View button by dragging both into the 
button bar in the Program Window (Image 8).

STEP 6
Click on the Multi-Cam View button to be able to 
see all your angles at once. Click on the Multi-
Cam Record button and now you’re able to record 
your keystrokes (Image 9).

STEP 7
As you watch the video, press the keypad numbers 
(1, 2, 3, and so on) that correspond to the camera 
you want active at that point in time. The red rim 
around the clips will show you which ones are ac-
tive in the Multi-Cam View. Once you press Stop, 
those cuts will appear on your MCSS. If you ever 
want to see the clips as regular clips again, you can  
RIGHT CLICK > MULT-CAM > FLATTEN.

Image 6: Enable this button to drag MCSS in as an intact MCSS.

Image 7: Open the Button Editor.

Image 8: Drag the Multi-Cam Record and Multi-Cam View buttons into Image 9: Enable Multi-Cam Recording. 
button bar.

Image 5: Right click and select “Multi-Camera Follows Nest Setting”
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Image 2: All the clips are now synced up.
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Sync Multiple Video Clips to Audio
In the Timeline

Image 1: All the clips on their own separate tracks.

RIGHT-CLICK and select “Synchronize.” Select 
“Audio track channel” as the Synchronize Point.
STEP 2:

WHERE: TIMELINE & PROJECT PANEL

This will allow you to sync multiple cameras with a 
single audio clip, all in the timeline itself, without 
using the Multi-Cam workflow. It is important to also 
record audio accompanying the video clips. This will 
allow you to use the scratch audio from the AV clips 
(those from your camera) to sync the external audio. 

STEP 1: Put all of the AV clips from your different 
camera angles on different tracks. These should all have 
scratch audio tracks attached to them. Also put your 
“good audio” on its own track. 

Now all of your clips will be lined up and synced together 
(Image 2). You can mute or disable the audio from the AV 
clips and only focus on the good audio.

Here I have Camera A in blue on tracks A1 and V1, Camera 
B in pink on Tracks A2 and V2, and the “good audio” on 
track V3, in green (Image 1).
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Image 3b: “W” cut and ripple delete.

Image 4a: Green clip needs to be longer 
and reach the blue line (Playhead).

Image 4b: SHIFT+Q extends green clip to 
the right, overwriting half of orange clip.

Image 5a: Green clip needs to start 
earlier, at the blue line (Playhead).

Image 5b: SHIFT+W extends green clip 
to the left, overwriting half of pink clip.
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RIPPLE TRIM PREV. EDIT TO PLAYHEAD: Q

RIPPLE TRIM NEXT EDIT TO PLAYHEAD: W

WHERE: TIMELINE

Cut & Ripple Trim to Playhead

Extend to Playhead & Select without Clicking

If you want to cut at your playhead, press CMD+K (CTRL+K 
on PC)(Image 1). This shortcut will only work on those 
tracks that have Track Targeting enabled (see page 5). For 
splicing across all tracks, add a SHIFT to this shortcut.

Q deletes what’s between the start of a clip and the playhead, 
and ripples everything after the clip (Images 2a / 2b).

W trims the tail end of a clip. It deletes what’s between the 
playhead and the end of the clip and ripples everything after 
the playhead (Images 3a / 3b). 

Image 1: CMD/CTLR+K slices down through only track targeted layers. 

Image 2a: This section of the 
green clip needs to be removed.

CUT AT PLAYHEAD: CMD+K (CTRL+K ON PC)

CUT ALL AT PLAYHEAD: SHFT+CMD+K (MAC)
SHFT+CTRL+K (PC)

Image 2b: “Q” cut and ripple delete.

EXTEND PREV. EDIT TO PLAYHEAD: SHFT+Q

EXTEND NEXT EDIT TO PLAYHEAD: SHFT+W

SHIFT+Q lengthens the clip that comes before the playhead 
to the playhead itself (Images 4a / 4b). 

SHIFT+W takes the cut point that follows the playhead, and 
extends it forward to reach the playhead (Images 5a / 5b).

“A” selects everything to the right of your cursor, while 
“SHIFT+A” selects everything to the left of your cursor.

TRACK SELECT FORWARD: A

Image 3a: This section of the 
yellow clipyellow clip needs to be removed.

TRACK SELECT BACK: SHFT+A
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Image 1: Transcribe Tab in Text Window.
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Text-Based Editing

Image 2: Text editing options inside the Transcribe Tab.

Image 4: Create Captions button.

Image 5: Caption Preferences window.

To create a transcript, first open up the Text 
workspace under WINDOW > TEXT and navigate to the 
Transcript tab (Image 1). It will show you which clips on 
your timeline can be transcribed. 

EXPORT TRANSCRIPT

Click “Transcribe”

Once you have your sequence transcript, you 
can edit this text just as you would any text editing 
application. You can change the spelling of words by 
double-clicking on the text and opening up the editor. 
You can highlight sections and click “delete” to delete 
them, copy, paste, etc. You can also RIGHT CLICK to see 
these options (Image 2). As you change your transcript, 
those changes will be reflected on your timeline.

Pauses are indicated by ellipses [...] and you can select 
those separately and delete them as well. 

STEP 2

STEP 3

STEP 1

Sometimes you may just want to send the entire un-
edited transcript to someone. This is more common in 
documentary scenarios. Just go to the three-dot menu 
on the top right of the Text Window and select “Export” 
and this will give you several export options (Image 3).

CREATE CAPTIONS/SUBTITLES

Click on the CC button (image 4) to open up the Captions 
dialog box. This will ask you your preferences including 
character length, minimum duration, and number of lines 
(Image 5). Once you have selected your preferences, 
click “Create captions.”

The captions will be added to a new “Subtitle” track 
above your video and audio tracks. You can still edit the 
captions from there - they act like clips on your timeline. 
You can move them around, change their timings, and 
change what they say by clicking into them (Image 6).

Image 3: Export Transcript Options.

Image 6: Subtitle Track.

PART 2: BUILDING
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Edit a Caption

Image 1: Properties Panel when a text clip is selected.

Image 4: Create New Text Style.

Image 2: Redefine Style button. Image 3: Add style to all captions.

WHERE: PROPERTIES PANEL 

You can update the look of all of the captions at once if 
anything (like color, font, and font size) need to change.

CREATE TRACK STYLE

Open the Properties Panel under WINDOW > 
PROPERTIES.
STEP 1:

With one or more caption clips selected in the 
timeline, in the Properties Panel, you can now adjust the 
parameters of that graphic like the font, color, size, add 
shading or a background box, etc (Image 1).

Remember that social media play/scrub bars cover the 
bottom of the screen, so don’t place your subtitle too 
close to the bottom of the frame.

STEP 2:

If you want to push those style attributes to 
the rest of the subtitles on the track, click the Redefine 
Style Button (Image 2) and select “All captions on 
track” in the pop-up (Image 3).

If you want to adjust the settings again, you can select 
just one text clip, adjust, and use the Redefine Style 
button to apply it across the whole track again.  

STEP 3:

You can also create a custom caption track style that you 
can take with you across other sequences.

Instead of clicking the Redefine Style button like in Step 
3 above, go to “Create Style” in the drop-down menu 
under the + button (Image 4) and give your new caption 
style a name. 

You can now name your new Text Style and save it just 
to the project you’re currently working on, to the “local” 
styles library on your computer), or both.

Now you can select any text in the whole project and 
use the Track Style drop-down menu to add Track Styles.

Premiere also creates that preset as an item in your 
Project window (bins). If you right-click and select 
“Export Text Styles” you can save this file for future 
use in other projects.

Image 5: New Text Style menu.

PART 2: BUILDING
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Auto-Translate Captions

STEP 1: After you have already created the captions in one language, you should see the Captions Track above all 
your video tracks. It should say “Subtitle” and be labeled C1. To create captions, see the previous pages.

STEP 2: Click on the three-dot menu in the Captions Tab 
of the Text Window, select “Translate Captions."

STEP 4: Your new translated captions will appear on their own Captions Track (C2) and you can toggle the visibility 
by pressing the EYE icon next to the track.

PART 2: BUILDING

STEP 3: Set your Source Language, Target Language, 
and Format. Once done, click “Translate.”
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Loop Playback of a Timeline Section

Image 2: Add Loop Playback Button to the button bar.

Image 1: Open Button Editor.

Image 3: Loop Playback Button enabled.

USE THE “LOOP PLAYBACK” FEATURE IF YOU WANT TO KEEP REPLAYING A SECTION OF YOUR VIDEO OVER AND 
OVER AGAIN TO CHECK FOR THE FLOW OR TO AUDITION DIFFERENT TAKES (VIDEO LAYERS). 

ENABLE THE LOOP BLACKBACK BUTTON

Go to the Button Editor “+” icon at the bot-
tom left of the Program Window (Image 1). 

STEP 2
Drag the Loop playback Button into your 
button bar (Image 2).

STEP 1

Enable the Loop Playback Button (it should 
turn blue, Image 3). By default, this will loop 
playback on the entire timeline.

STEP 3

Image 4: Only this section will play when Loop Playback is enabled.

SELECT A SECTION TO LOOP PLAYBACK

Put your playhead at the beginning of the 
section you want to play back and press “I” 
to set the In Point. 

Put your playhead at the end of the section 
you want to play back and press “O” to set 
the Out Point.

That section should turn a light gray in the 
timeline (Image 4).

STEP 2

STEP 1

With the Loop Playback Button enabled, 
press the SPACEBAR or the Play button in 
the Program Window. 

STEP 3

To clear the In and Out points, RIGHT CLICK 
in the gray area next to the time indicator 
and select “Clear In and Out” (Image 5).

STEP 4

Image 5: Clear In and Out Points.
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Choose from the pre-loaded LUTs of upload your own .cube file to 
quickly add color to footage shot in log (flat profiles).

Adjust the temperature and tint of your image to make it warmer, 
cooler, or take away/add green.

You can use the eyedropper to pick an area of pure white in your 
image and the white balance will be adjusted to reflect that.

Make basic changes to the image like increasing the brightness 
(Exposure), making the colors more saturated (Saturation), or 
making the blacks blacker and the whites whiter (Contrast).  

WHITE BALANCE

TONE

INPUT LUT

Click “Auto” to have the program adjust these basic settings for 
you. You can always adjust later if needed.

AUTO SETTINGS

Cycle through Lumetri Looks, which act like filters on the image.
You can change their intensity with the Intensity slider.

LOOK

Add haziness with the Faded Film slider, sharpen your clip, and 
add vibrance and saturation.

Add a tint to your highlights or shadows by dragging the middle 
pointer around the color wheel.

SHADOW/HIGHLIGHT TINT

ADJUSTMENTS

CREATIVE

Adjust how much of the tint added should be given priority to the 
shadows vs the highlights.

TINT BALANCE
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Lumetri Color Panel
This panel helps you adjust the colors of your clips. Once you change any value in the Lumetri Color Panel, the Lumetri 
Color effect will be added to that clip. You can then copy/paste that effect from the Effect Controls window onto other 
clips.

BASIC CORRECTION



Place points along the curve to adjust the luma values of either 
the entire clip or individual red, green, and blue channels.

Adjust the saturation of areas that are over or under-saturated.
SAT VS SAT

Adjust the saturation of a specific hue range.
HUE VS SAT

Adjust the hue of a specific hue range.

Adjust the brightness (luma) of a specific hue range.
HUE VS LUMA

HUE VS HUE

HUE/SATURATION CURVES

Adjust the saturation of a specific luminance range.
LUMA VS SAT

Isolate a specific range of hues, luminances, or saturation values 
to adjust. Select a range by placing three dots on the line. The 
left and right dots indicate the boundaries of the range and the 
middle dot is dragged up and down to change that value.
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Lumetri Color Panel Cont.
RGB CURVES

PART 3: REFINEMENT



This section can help you match the clip you are working on with 
another clip in your sequence.

Pull up this view to choose which part of your sequence 
(reference) you want to match to.

If there is a face in both the clip you are trying to correct and the 
reference clip you are using, turn on the Face Detection setting 
to more accurately match up the skin tones between both clips.

COMPARISON VIEW

FACE DETECTION

COLOR MATCH

This section will let you isolate a specific color or color range 
and change the hue, saturation, and luma values of just that 
specific range of colors. You can use the eyedroppers on the clip 
itself for a more accurate selection.

KEY

Specify the selection accuracy by adding noise to the selection 
or blurring the selection. This will help smooth over any hard 
edges, allowing for a seamless transition. 

REFINE

Add secondary “basic correction” to a selected color range.
CORRECTION

HSL SECONDARY

Add or subtract a vignette, including how much you want to add, 
where the midpoint is, and how round or feathered the vignette 
should be. This can create emphasis for the middle subject in 
your clip or get rid of wide-angle vignetting in some lenses.

VIGNETTE
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COLOR WHEELS & MATCH

Lumetri Color 
Panel Cont.
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Image 2: Audition different looks by pressing the right and left arrows.

Image 3: Change the intensity of the look being applied to your footage.

Image 1: Select a look from the drop-down menu.

SL BLUE ICE

SL IRON LDR

SL CROSS HDR

SL MATRIX BLUE
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WHERE: LUMETRI COLOR PANEL 

Looks
& PROGRAM MONITOR

ADDING A LOOK

Under the “Creative” tab of the Lumetri Color Panel, click 
the drop-down menu to open up the Looks Premiere 
comes pre-installed with. 

Selecting a look from the drop-down menu will apply it to your 
clip, but you can also quickly preview the looks within the 
Lumetri Color Panel by clicking on the right and left arrows 
next to the preview display (Image 2). Click on the preview 
image to apply the look to your clip.  

You can also change the intensity of the look by using 
the intensity slider located directly underneath (Image 3).

If you want to import a Premiere look, just choose “Browse” 
from the drop down menu and navigate to the .look file you 
want to use. 

HERE ARE SOME EXAMPLES OF HOW DIFFERENT LOOKS APPEAR ON THE SAME CLIP:
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Image 1: Labeling a clip as Magenta.

Image 3: The Lumetri Color in the Effects Rack of Effect Controls Panel.

Image 4: Selecting multiple clips with a marquee box.

Image 2: Footage from two different angles is labeled differently.

Image 5: Remove Attributes option.

Image 6: Uncheck all the attributes except for Lumetri Color.
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Add & Remove 
Lumetri Color

If the clip is already in your timeline, to add a label, 
right click on the clip and select your color from the Label 
options (Image 1). 

To select multiple clips, hold down SHIFT + ALT (OPTION) 
while clicking on multiple clips. In this example, I have labeled 
all the B-cam footage magenta and all the A-Cam footage Iris 
Blue (Image 2).

STEP 1:

Once you have adjusted one clip in the Lumetri 
Color Panel, those changes all go under the “Lumetri 
Color” effect in the Effect Controls Panel (Image 3). 
Copy the effect by selecting the words “Lumetri Color” 
and pressing COMMAND (CTRL) + C.

STEP 2:

ADDING LUMETRI COLOR TO LABEL GROUPS

Right-click on the clip and go to LABEL > SELECT 
LABEL GROUP to select all the other clips in that label 
group. While holding down SHIFT, deselect the one clip you 
already applied the Lumetri Color effect to. Press COMMAND 
(CTRL) + V to apply the effect to every clip in that label group.

STEP 3:

REMOVING LUMETRI COLOR FROM MULTIPLE CLIPS

Use label groups to help differentiate different cameras, 
different angles, or anything that can help you organize 
and differentiate your clips.

WHERE: EFFECT CONTROLS PANEL
& TIMELINE

Draw a marquee box around multiple clips (Image 
4), select all your clips with COMMAND (CTRL) + A, or select 
a label group as described in Step 3 above.

STEP 1:

Right-click, go to Remove Attributes (Image 5).STEP 2:

Uncheck all the boxes for the attributes you do 
not want to remove. In this case, if you just want to remove 
the color correction from the selected clips, leave only the 
Lumetri Color effect selected (Image 6).

STEP 3:

Click the “OK” button.STEP 4:
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Image 1: Selecting multiple clips with a marquee box.

35

WHERE: TIMELINE, EFFECT CONTROLS PANEL, AND PROJECT PANEL

Lumetri Color via Adjustment Layer
Adjustment layers help you add effects to regions of the timeline as a whole. If you already know that everything you’ve 
shot was with the same camera and at the same time of day, you can apply an adjustment layer across the entire 
timeline. Adjustment layers only affect the tracks underneath them, not above them. 

Click on the icon of the page with the upturned 
corner on the bottom right of the Project Panel and 
select “Adjustment Layer” (Image 1).

Make sure your new adjustment layer is set to the same dimensions and frame rate as your sequence. Press “OK.”

Drag the adjustment layer onto your timeline, above every track that you want the adjustment layer to affect. Here in 
this example, there are already 4 tracks of video layers so the adjustment layer will go on the V5 track.

STEP 2

STEP 3

STEP 1

Extend the length of the adjustment layer across the top of all the footage you want it to adjust.
STEP 4

With the adjustment layer selected, move the sliders in the Lumetri Color Panel to add color correction. Or copy/paste 
Lumetri Color (or any other effect) to the into the Effect Controls window when the layer is selected.

STEP 5
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In the search bar of the Adobe Stock tab, enter what type of graphic 
you’re looking for. Here, I’m looking for a free title graphic, so I type 
“title” and check the “free” box (Image 2).

Drag the desired graphic onto your timeline.

Select your new graphic in the timeline and use the options in the 
Properties Panel (Image 3) to customize your graphic to your needs.

STEP 2

STEP 3

STEP 1
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Using Graphic Templates
The Graphic Templates Window lets you see which graphics 
templates are stored locally on your computer (My Templates) as 
well as which templates are available from Adobe Stock (Image 1).

To see the graphics from Adobe Stock, you need to click on the 
“Adobe Stock” button. Here you can search for Free or Premium 
templates. Hover-scrub your mouse over the thumbnail to preview.

CUSTOMIZE A GRAPHIC

Image 2: Searching for a graphic from Adobe Stock.

Image 1: Many graphics are available in the “Adobe Stock” tab of the Graphic Templates Window.

Image 3: Edit controls of new graphic.
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Image 2: Generative Extend Tool in the Tool Panel. Image 3: Clip tagged “AI Generated” for the footage created with Generative Extend.

If you cannot find what you’re looking for - whether it’s a piece of dialogue, text on the screen, or an object - you can search 
directly for it in the new “Search” Window. Just type whatever you’re looking for into the search field, and select what type 
of content you’d like Premiere to search through from the drop-down menu (Image 1).
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Media Intelligence & Search Panel

PART 3: REFINEMENT

Image 1: Searching for images of a tennis ball within the source clips of the project.

Generative Extend
If you don’t have enough footage or audio at the beginning or end of your clip and you need to generate a few extra seconds, 
use the Generative Extend Tool (Image 2) to click and drag the end of your clip. An “AI Generated” tag will be added to the 
part of the clip that is newly generated (Image 3). 

Note: this will only work on clips up to 30 frames per second and will generate up to 2 extra seconds of video or 10 extra 
seconds of audio. This is a premium feature.
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Essential Sound - Edit Dialogue
LOUDNESS
By selecting “Auto Match,” the clip each clip is adjusted to 
match common broadcast loudness requirements.

REPAIR
REDUCE NOISE
Get rid of unwanted noises in the background, like microphone 
noise or wind.
REDUCE RUMBLE
Reduce low-frequency noise in the 80-Hz range.

DEHUM
Hum is noise that consists of a single frequency. Electrical cables 
that are too close to audio cables can cause this noise. 50-Hz hum 
is common in Europe, Asia, and Africa. 60-Hz hum is common in 
North and South America.

DEESS
Reduce high-frequency “s” sounds like those created by saying 
words with s-sounds that are close to the microphone.
REDUCE REVERB
Remove the room reverb when recording in echo-y rooms.
CLARITY
DYNAMICS
Compress or expand the dynamic range of the recording.

EQ
Reduce or boost select frequencies. You can choose common ones 
from the drop-down menu, including Old Radio and Podcast Voice.

ENHANCE SPEECH
Emphasizes certain frequencies and compresses the voice to give 
a more polished sound.

CREATIVE: REVERB
You can add reverb to make it sound like your audio was recorded 
in different types of rooms, like a church or auditorium.

CLIP VOLUME
Change the volume of the entire clip or mute it. For other ways to 
change clip volume, see Page 7.

PART 3: REFINEMENT



Image 1: Browse Tab and Essential Sound Browse options.
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Find Stock Sound

Image 2: Timeline sync toggle in the Essential Sound Browse tab.

Image 3: License from Adobe Stock.

Image 5: Invisible cut. Image 6: Expand Audio Track.

Adobe has partnered with several sound libraries to 
bring stock music and sound effects options to Premiere 
Pro! Here’s how to find what you’re looking for.

Open the Essential Sound panel by selecting 
“Essential Sound” from the Window menu.
STEP 1:

Go to the Browse Tab. Here you can search 
by Mood, Genre, Tempo in Beats Per Minute (BPM), 
Duration (how long the track is), Vocals vs Instrumental, 
and choose which sound libraries you want to search. 

STEP 2:

Put your playhead (blue line) where you’d 
like the track to start on your sequence. Make sure 
“Timeline Sync” at the bottom of the Essential Sound 
panel is checked off (Image 2). Now you can audition 
how each track sounds like in your sequence by pressing 
the little Play Button to the left of each track name.

STEP 3:

Once you find the track you like, drag it 
directly onto the Audio Tracks in your timeline. This will 
create a new Bin called “Stock Audio Media.” Before 
you’re done with your project, make sure you license the 
track by selecting the shopping cart icon (Image 3) next 
ot the track name. 

STEP 4:

PART 3: REFINEMENT

Remix Audio
Remix is an AI tool that lets you shorten or lengthen any 
audio clip, without changing the speed. It simply adds 
or takes away sections of the audio clip, seamlessly 
creating a new clip of the desired length.

To use, click and hold on the third tool icon in the Tool 
Bar. This will bring up the drop-down option to select the 
Remix Tool (Image 4). 

With the Remix Tool enabled, hover over the end of an 
audio clip and drag it left or right, to your desired length.

After a few seconds, you’ll see invisible cuts where the 
audio sections have been joined together, indicated by 
squiggly lines (Image 5). If you cannot see those clearly, 
expand the size of the audio track by clicking in the area 
between audio tracks and dragging down (Image 6).

Image 4: Remix Tool.



Image 1: Disable stopwatch icon and 
change the level in Effect Controls.

Image 2a: Hover over the edge of the 
track to expand it.

Image 2b: Drag the white volume line up 
or down to change the volume.

Image 3: Expanding the mix track to reveal the volume line.

Image 2c: The second half of the audio clip has been lowered by 16.6 dBs.

Image 4: Volume adjustment in the 
Essential Sound Panel.

Image 8: Control volume levels of each 
track in the Audio Track Mixer.

Image 5: Volume adjustment in 
the Properties Panel. 
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4: SHORTCUT
Select an audio clip you want ot adjust and press “]” to 
increase the volume by 1 dB (decibel) or press “[” to 
decrease the volume by 1 dB. 

5: MASTER VOLUME TRACK
To change the volume across your entire timeline, expand 
the master volume track on the bottom of your Sequence 
Panel (Image 3). 

Then drag the white line up or down, just like in #3 above.

3: EXPAND AUDIO TRACK
When you expand the view of your audio track in your 
timeline by making the track size taller (Image 2a), you 
will see a white line appear in the middle of all the audio 
clips on that track (Image 2b). You can drag that white line 
up and down, increasing and decreasing the volume. 

COMMAND (CTRL) + clicking on the white line will create 
a keyframe. If you create at least 2 keyframes, you can 
now change the volume of a section of a clip by dragging 
portions of the white line up or down (Image 2c).

6: ESSENTIAL SOUND PANEL & 7: PROPERTIES PANEL

Change Clip Volume - 8 Ways

2: EFFECT CONTROLS PANEL
Select the audio clip and go to the Effect Controls Panel. In AUDIO > VOLUME > LEVEL, 
disable the stopwatch icon (turns blue to gray) and drag the decibel number left or right 
(or type it in) to change it (Image 1). You can copy/paste the volume effect to other clips. 

1: AUDIO GAIN
Right click on the selected audio clip(s) and select Audio Gain. Type in the gain adjustment 
you want to apply.

Open the Essential Sound Panel, select the clip(s) you want to adjust and assign them as 
dialogue, music, SFX, or ambience. Go to the bottom of the Essential Sound Panel and use 
the volume slider to adjust the volume (Image 4). This method uses the Hard Limiter effect, 
so will not allow the audio to clip (go into the red).
The Properties Panel also has a slider (Image 5).
 8: AUDIO TRACK MIXER
Go to WINDOW > AUDIO TRACK MIXER and control the levels of each track in your 
timeline by sliding the Volume controller up and down on the left side of each track level 
(Image 5).

PART 3: REFINEMENT



Image 1: Audio Fade Handle. Image 2: Audio Fade on Purple Clip alone. 

Image 4: Setting Default Audio Transition in Effects Window. Image 5: Setting Default Transition Timing in Timeline Menu.

Image 3: Crossfade between Yellow and Purple.

Dragging the fade handle towards its own clip will create a fade on the clip. In Image 2, the fade handle on the purple clip 
was dragged to the right, therefore creating a fade just on the purple clip.  

Dragging the fade handle towards and across another clip will create a crossfade. In Image 3, the fade handle on the purple 
clip was dragged to the left, creating a crossfade in-between the yellow and purple clips.

You can also drag your mouse up and down to change the slope (speed) of the fade, shows as “cosine value.”

STEP 2
Locate the audio fade handle - it should look like a small square in the top corner of the audio track (Image 1).
STEP 1

To set the default transition of an audio clip, go to the “Audio Transitions” Bin in the EFFECTS Window, RIGHT CLICK, and 
choose “Set Selected as Default Transition” in the drop-down menu (Image 4). You can also do this with video transitions.

To set the default transition duration, go to EDIT > PREFERENCES > TIMELINE and this is where you can write in how 
many seconds or frames you want your default transitions to be (Image 5). 

STEP 2

STEP 1

To apply a default transition, select the cut itself in your timeline and press “SHIFT + D.”
STEP 3
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Using Audio Fade Handles
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Create and Apply Default Transitions



Image 4: After setting your sliders, select “Generate Keyframes.”

Image 5: Where there was no dialogue, the volume of the music increased.

Image 6a: Higher duck amount. Image 6b: Higher fade speed.

WHERE: ESSENTIAL SOUND PANEL 
            AND TIMELINE

WHAT: AUTO-FADE MUSIC
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Go to WINDOW > ESSENTIAL SOUND and the Essential 
Sound Panel should appear on the right of your screen.

Select all of your “talking” audio (in this example, it’s 
the purple clips on track A1) by drawing a box. It’s ok if 
any linked video clips are selected too (Image 1).  In this 
example, we are going to make the music (green clip on 
track A3) louder, only during the parts where a person is not 
speaking (blue clips in timelines).

With all your “talking” clips still selected (Image 1), CLICK 
the “Dialogue” button in the Essential Sound Panel (Image 
2a) to tag these “talking” audio clips as “Dialogue.”

STEP 2

STEP 3

Auto-Ducking Music Under Dialogue

STEP 1

Image 1: Select just the dialogue audio by holding OPT (ALT) and dragging.

Image 2a: Tagging as Dialogue.

Select your music clip (green clip on track A2) and tag it as 
“Music” in the Essential Sound Panel (Image 2b).

With the music still selected, CLICK the checkmark for 
“Ducking” in the Essential Sound Panel and CLICK the 
speech icon to “Duck Against Dialogue Clips” (Image 
3). This means you will be using the clips you tagged as 
“Dialogue” as reference for the music ducking.

Use the sliders to choose how sensitive you want the ducking 
to be, how intense you want each fade to be, and how 
quickly you want the fades to occur. CLICK the “Generate 
Keyframes” button (Image 4) to activate ducking. Now 
the white volume line in the middle of the audio track has 
keyframes applied (Image 5). If you want the ducking to be 
more severe (Image 6a) or the fades to be faster (Image 6b), 
adjust the sliders and RE-CLICK “Generate Keyframes.”

STEP 5

STEP 6

STEP 4

Image 3: With the Ducking option checked, select the Dialogue icon.

Image 2b: Tagging as Music.
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Image 1: Reveal Sequence in Project. Image 2: Changing the dimensions of the new sequence.

Image 3: Auto Reframe Sequence settings. Image 4: Toggle Auto Reframe on/off.

Duplicate the sequence by selecting it in the Project Window, right clicking and selecting “Duplicate.” You can now click on 
the name of the duplicate and rename it to something different (rather than keeping the default suffix “Copy 01”). Double-click 
to open the new sequence in your timeline.

If you are creating a duplicate in order to make a version with a different frame size (like a vertical version for Instagram), go to 
SEQUENCE > SEQUENCE SETTINGS at the top of the program and change the dimensions of the sequence (Image 2).

STEP 2
Find your sequence. Right-click its name in at the top of the timeline and select “Reveal Sequence in Project” (Image 1).
STEP 1
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Duplicate Sequence for Versioning
VERSIONING YOUR SEQUENCES IS LIKE SAVING YOUR WORK. EVERY TIME YOU GET NEW FEEDBACK FROM A 
CLIENT OR WANT TO SAVE YOUR VIDEO IN ITS CURRENT STATE BEFORE MAKING CHANGES, CREATE A VERSION.

PART 3: REFINEMENT

Auto-Reframe Sequence
STEP 1
After following Step 1 above, instead of right-clicking and selecting “Duplicate,” select “Auto Reframe Sequence.”
STEP 2
In the pop-up box, you can choose your new sequence dimensions and give it a new name (Image 3). You can also help the AI out 
by letting it know whether the sequence has fast or slow-moving subjects. Press “Create” when done.
Sometimes you need to customize or override the reframing. You can do so in the Effect Controls Window. Toggling the “fx” 
button next to “Auto Reframe” (Image 4) will turn it off and you can use your standard Motion controls above to manually 
reframe. You can also use the controls in the Auto Reframe effect to adjust the position or offset of the reframing.



Image 1: The region in the yellow oval needs rendering.

Image 2: The region has been selected with In/Out Points.

Image 3: The region is rendering from the left to the right.

Image 4: Open the Export WorkflowImage 4: Open the Export Workflow.

Image 5: Enable Burned-in Captions. Image 6: Select the Export range.
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RENDERING WILL HELP YOU SMOOTH OUT YOUR 
VIDEO PLAYBACK AND SPEED UP YOUR EXPORT.

Rendering
To see which areas need to be rendered, look at the 
colored line indicator right underneath the time display 
on the timeline. If there are areas of yellow or red, those 
may need to be rendered for faster playback (Image 1).

Select the area you want to render by setting 
in and out points. Place your playhead at the beginning 
of the area and press “I” on your keyboard. 

Then place your playhead at the end of the area you 
want to render and press “O” on your keyboard. The area 
should be highlighted in light gray (Image 2).

STEP 1:

STEP 2: Go to SEQUENCE > RENDER IN TO OUT. 
This will render the gray-highlighted region from left to 
right, turning the top line green (Image 3). If you 
want to pause, click “Cancel” and save your project, 
so the render of the clips you’ve done so far will be 
saved.

As you are rendering, you will also see how much 
time you have left on your render and the 
percentage it is finished (Image 3).

Exporting

PART 3: REFINEMENT

Go to the Export Workflow by clicking EXPORT 
at the top left of the screen (Image 4).
STEP 1:

Click next to “File Name” to change the name 
of the file and the Location on your drive where you want 
this to be saved.

I recommend saving YouTube videos with an H.264 
format and Preset of “Match Source - Adaptive High 
Bitrate.” If you want your captions to be visible on your 
video, make sure you enable Captions (Image 5) and if 
you only want to export the section you have indicated 
using In/Out points (Step 1 on this page), select “Source 
In/Out” in “Range” (Image 6).

STEP 2:

Clicking “Export” will export your video, but if 
you want to continue workign on something else inside 
Premiere Pro in the meantime, click “Queue” instead, 
and Premiere Pro will send your project to Adobe Media 
Encoder for Exporting.

STEP 3:



Thank You!
Thank you for taking my course. I hope that you are now more prepared to start editing with 
confi-dence! If you have any issues or questions about Creative Cloud programs, feel free to leave 
a comment on this video!

If you’d like to keep in touch with me, I’m @valentinavee on X and @valentina.vee on Instagram. 

-Valentina


